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1 Introduction



If you have Windows 95 installed on your PC, you can use either the NTS Winsock supplied with Turnpike to access the Internet or the one provided as part of the Windows 95 Dial-Up Networking (DUN) software.



Either of these Winsocks can be used not just with Turnpike but also with any Internet applications that you wish to run alongside Turnpike - whether 16bit or 32bit.



In general, it is easiest and most convenient to use the NTS Winsock provided with Turnpike, because this allows you to run the Turnpike Connect program and go on-line in one smooth action. Setting up the Windows 95 DUN and using it to dial up your Access provider is not a simple task.



But in case you particularly want to use the DUN's auto-dial feature or you need it to support some exotic hardware you are using, this document describes the special features of running Turnpike alongside the DUN. It also explains how to install and configure the DUN software because this isn't always clear to Windows 95 users.



If you are happy to use the NTS Winsock supplied with Turnpike, you can ignore this document.



Note: If you need to use the Windows 95 Winsock but you have already installed Turnpike's own Winsock, don't worry: just use the Winsock used option offered in the Turnpike Connect program to select the DUN Winsock instead. (To be tidy, you could then remove the WINSOCK.NTS and WSOCK32.NTS files from your Windows directories - but it's not essential to do this.). 



You should also note that Windows 95 Set-Up disks are needed for some of the steps described in this document.





�2 Installing and Configuring your modem



Call up the Control Panel (for example, from the Settings option of the Start menu) and double-click on the Modems icon.



With no modem yet installed on your PC, you should see an 'Install New Modem' dialog.



	If a modem is installed, you will see instead a list of modems. If your modem is listed, go on to set its properties: see below. If not, click the Add button to display this 'Install New Modem' dialog.



Opt for Windows to detect the modem (by ensuring that the tick box by the 'Don't detect' option is cleared), then click Next.



Windows then tries to identify your modem.



If your modem is correctly identified, simply click the Next button.



If it isn't correctly identified, click the Change button and select the modem's manufacturer and model from the list displayed.



	If your modem isn't listed, either take the 'Have disk' option if a disk was supplied with the modem or select the 'Standard' modem of the appropriate baud rate (from the top of the Manufacturers list).



When you are ready to continue, click the Next button and, if necessary, set the port to which the modem is attached.



If you are installing a modem for the first time, you will then be asked for details of your location and your phone system.



In the final dialog, you are offered a Finish button. When you click this, you will be put into the Modem Properties dialog from where you can set the properties of your modem as described below.



Setting its properties



Check your modem is selected in the Modem Properties dialog, then click the Properties button and set its properties as follows.



General properties (Displayed first)



The speaker volume is up to you but the speed to set depends on the modem and the type of UART in the COM port - and also on how fast your PC is able to respond. Ideally, the speed set here should be 4 times the modem speed eg. 57600 for a 14.4k modem or 115200 for a 28.8k modem. But data can only be transmitted at these speeds if the COM port uses a 16550 UART (and then only if the PC itself can cope at these speeds). If it uses a 16450 UART, the highest speed to set is 38400, while if it uses an 8250 UART, the limit becomes 19200.



Note: If you don't know what type of UART is used, you can find out by returning to the Modem Properties dialog, switching to the Diagnostics display, selecting the appropriate port and clicking the More info button.



Connection properties (Displayed by clicking on the Connection tab).



Connection preferences: The default settings of '8, None, 1' are the ones you are likely to need here.



Call preferences: The 'Wait for dial tone' option should be selected unless your modem isn't able to detect the appropriate dial tone.



Now click the Advanced button to show the 'Advanced Connection Settings' dialog.



Error control: is automatically selected where it is supported by your modem.



Flow control: Here you need to select the form of Flow control used by your Access provider.



Modulation type: The 'Standard' setting should be fine.



Extra settings: Slot for additional modem initialisation commands. These may be needed if Windows 95 didn't recognise your modem.



	When you have finished setting your modem's properties, click OK/Close until you are back to the Control Panel.





3 Installing the Dial-Up Networking (DUN) software



	This is done from the Control Panel which is called up, for example, from the Settings option of the Start menu.



Double-click on the Add/Remove programs icon in the Control Panel. 



Click the Windows Setup tab of the Add/Remove Programs Preferences dialog that is displayed, select the Communications option and click the Details button in the Communications dialog.



Tick Dial-Up Networking, and click OK - then click OK again to leave the Add/Remove programs dialog.



	If Dial-Up Networking is already ticked, just click OK back to the Control Panel, then go on to Part 4.



Follow the instructions that appear on the screen to install the DUN software.



When the 'Network' dialog is displayed, fill in your 'host' or 'node' name as your 'Computer name' and an appropriate 'Workgroup name'. (If you are a Demon customer, your nodename is the unique account name you chose when you set up your account.)



You can also fill in a Computer description if you wish.



Then restart your computer when you are prompted to do this.



You next need to install the TCP/IP software.





4 Installing the TCP/IP software



	This is also done from the Control Panel (called up, for example, from the Settings option of the Start menu).



Double-click on the Network icon in the Control Panel to display a list of the installed Network components.



If TCP/IP isn't listed, click Add and select Protocols from the list of Network Component Types that is displayed. 



	If TCP/IP is listed, simply select it - then set its properties as described below.



Click Add again and select Microsoft TCP/IP from the following list of Network Protocols.



Click OK, then set the TCP/IP properties as described below.



TCP/IP Properties



To set these, select TCP/IP in the list of Network components (as described above) and click the Properties button.



IP Address page of dialog

Take the 'Obtain automatically' option - unless specifically told otherwise by your Access provider.



WINS configuration page of dialog

Take the 'Disable' option - unless you are on a local network where WINS is used.



Gateway page of dialog

Set this if your Access provider or Network manager tells you the number to use, but otherwise leave it blank. This gateway doesn't have any real meaning on a dial-up connection.



Bindings page of dialog

The default is for TCP/IP to be bound to Client for Microsoft Networks. Leave it like this.



Advanced page of dialog

You don't need to alter this.



DNS configuration page of dialog

You can find out the addresses you need by running the Turnpike Connect program and taking the Service access option from the Configure menu.



	When you have finished making these settings, click OK back to the Network dialog and install the Dial-Up Adapter as described below.





�5 Installing the Dial-Up Adapter



If the list of Network components is not already displayed, double-click Network in the Control Panel to call it up.



	If Dial-Up Adapter is already listed, ensure that Windows Logon is selected as the Primary Network Logon, then set the properties of the Dial-Up Adapter as described below.



If Dial-Up Adapter isn't listed, click the Add button and select Adapter from the list of Network Component Types.



Click Add again and select Microsoft Dial-Up Adapter from the following list of Network adapters.



When you return to the main list, ensure 'Windows Logon' is selected as the Primary Network Logon - then set the properties of the Dial-Up Adapter as described below.



Dial-Up Adapter properties

	

	To set these, select Dial-Up Adapter in the list of Network components (see above) and click the Properties button.



Driver Type  page of dialog

Leave this alone.



Bindings page of dialog

Ensure that TCP/IP is ticked - and that the other protocols are cleared. 



Advanced page of dialog

Leave these settings alone too.



	When all set, click OK/Close back to the Control Panel. You now need to set up an icon for the connection you wish to make as described below.





6 Setting up the Connection icon



Select 'My computer' and open the Dial-Up Networking folder.



Assuming this is the first time you have gone into this folder, you will see a Welcome screen followed by a 'Make New Connection' dialog.



	If you have another connection set up, open the Dial-Up Networking folder and click on the Make New Connection icon.



Enter a name for the connection (such as Demon Internet), and select the modem you intend to use (if you have a choice).



Click Next.



In the next dialog, enter the details needed to phone your Access provider.



Be sure to set the Country code to the correct country.



Click Next, then click Finish in the next display.



You are then returned to the Dial-Up Networking folder.



Back in the Dial-Up Networking folder, select the new connection icon, then take Properties from the File menu. (This will display the basic details of the connection you've set up.)



Click the Server Type button and set the required details in the dialog that's displayed.



Advanced options: Clear these options unless specifically needed.



Allowed network protocols: Ensure that TCP/IP is ticked and that the other protocols are cleared.



Then click the TCP/IP Settings button, and set your Access Provider's DNS addresses in the following TCP/IP Settings  dialog.



IP address: Select Server assigned IP address unless specifically told otherwise by your Access provider.



Name server details: The numbers needed here are the ones you entered when setting the TCP/IP properties (see Part 4).



	When you have finished setting these Server details, click OK back to the DUN folder.





7 Dialling up



Note: Dialling up is easiest with the different pieces of information you need to give recorded as a 'script'. However, this requires extra software as Windows 95 itself doesn't support dialling scripts. If you have suitable scripting software (or you would like to know how to acquire this), see Part 8 below on 'Using a Dial-up script'. Otherwise, dial up as described here.



Dialling up without a script



Preparation



If you will be dialling up without a script, you first need to arrange that a terminal window will be displayed after dialling for you to enter the different pieces of information that your Access provider requires. 



To do this, select the appropriate Connection icon in your Dial-Up Networking folder, take the Properties option from the File menu, then click the Configure button under the modem in the Connection details that are displayed. (This displays the basic details of the connection.)



When the dialog appears, click the Options tab to display the Options page of the dialog and tick the option to Bring up terminal window after dialing.



Then click OK back to the Dial-Up Networking folder.



�When you are ready to dial



First run the Turnpike Connect program.



When the following 'third party Winsock' message appears leave this message on the screen for the moment and switch either to some other application or to the appropriate Connection icon in your Dial-Up Networking folder and use this to connect to the Internet. You will then see a 'Connect to' dialog.



Leave the slots for your username and password blank, and simply click the Connect button.



After dialling, a 'Post-Dial Terminal Screen' window will be displayed - probably containing brief details of the connection that has been made, followed by one or more requests for information. 



The likely sequence is login name (ie. user or 'nodename'), password, then protocol (normally PPP).



To each such request, type the appropriate details and press [RETURN]. After the last item, click Continue (or press [f7]). 



When you are connected, you will see a 'Connected to' dialog showing your Access provider.



At this point, you need to promptly switch back to the Connect program and allow this to continue.





8 Using a Dial-up script



Typing the different pieces of information your Access provider requires every time you connect can be tedious. A better solution is to set up a 'script' that will provide this information for you. 



Windows 95 doesn't itself support dialling scripts. To get this facility, you need to add either the Dial-Up Scripting Tool from the Windows 95 CD ROM, or the Internet Jumpstart Kit provided as part of Microsoft Plus - or one of the third-party scripting programs that are available.



If you don't have any scripting software at the moment, you can download a copy of the basic Microsoft scripting tool software from our FTP site (ftp: //ftp.turnpike.com/pub/win95/dscript.exe) or, for faster transfer, from our mirror at Demon (ftp://ftp.demon.co.uk/pub/mirrors/turnpike/win95/dscript.exe).



Stored alongside this software is a file called demon.scp which provides the basis for a suitable script for Demon customers. This script may also be adaptable for use with other Access providers as pretty much the same procedures are used by most Access providers.



We suggest you create a Windows.95 directory within your main Turnpike directory, dial up as described in Part 7, and use Turnpike's FTP program to copy these files to your Turnpike\Windows.95 directory. Then install the scripting tool and the script as described below.



To install the scripting tool



The first step is to extract the various component files that go to make up the Dial-Up Scripting Tool.



dscript.exe is a self-extracting .exe file, so to do this, you need to start a DOS session (by taking MS-DOS Prompt from the Start | Programs menu), change directory to your Turnpike\Windows.95 directory, and then run dscript.exe with the command dscript[RETURN].



When the files have been extracted, exit from the DOS session and call up the Control Panel (eg. by taking Control Panel from the Start | Settings menu). Double-click on the Add/Remove Programs icon, then when the dialog appears, click on the Windows Setup tab, then click the Have disk button.



When the 'Install from disk' dialog appears, click the Browse button and select the rnaplus.inf file from your Turnpike\Windows.95 directory - then click OK. You will then see a panel containing the single entry Slip and Scripting for Dial-Up Networking. Tick the box beside this entry, then click Install.



When you return to the Add/Remove Programs dialog, click OK.



To install the supplied script



Open the Dial-Up Scripting Tool now shown in the Start | Programs | Accessories menu.



When the Dial-Up Scripting Tool dialog appears, check that the appropriate connection is selected, then use the Browse button in the Dial-Up Scripting Tool dialog to pick out the demon.scp file from your Turnpike\Windows.95 directory.



(If you want to see what is in the script you've selected or you expect to need to change it, click the Edit button when you return to the Dial-Up Scripting Tool dialog.)



Back in the Dial-Up Scripting Tool dialog, check that the option to Start terminal screen minimized isn't ticked, then click the Properties button underneath the list of connections. When the Connection Properties dialog appears, click the Configure button below the modem details, click the Options tab of the Modem Properties dialog and ensure that neither Bring up terminal window option is ticked.



When you've done this, click OK back to the Windows Desktop - pausing only to accept the offer to save the changes you've made to the connection if this is offered.



When you are ready to dial



Run the Turnpike Connect program, then switch to your Dial-Up Networking folder and double-click on the appropriate connection icon in very much the same way as described in Part 7.



However, this time when the dialog appears, check that your username and password are entered in the slots provided before clicking the Connect button. (Note: These details may be filled in for you as your username is automatically saved while there's a special option to save your password.)



You should then go straight through to the 'Connected' dialog without any further intervention from you - at which point, you should then promptly switch back to the Connect program and allow this to continue. 
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